
 
 

Managing Your Citations With RefWorks  
(Note: this guide is closely modeled on one created by the University of Michigan 

that is available at http://www.lib.umich.edu/knc/howto/citation/refworks.pdf) 
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What is RefWorks? 

RefWorks is a bibliographic management service used for storing and organizing 
citations and formatting bibliographies.  It is similar to EndNote, ProCite, and Reference 
Manager but is Web based.  This means that your citations and the RefWorks system are 
stored on the RefWorks server; you can add to your database and use it with Microsoft 
Word from any computer that has Internet access. 

 
Creating and Accessing your RefWorks Account 

 

 

 

Creating Your Account  
In the New User Information for
University of Pennsylvania Libra
screen, enter your name, login na
password, e-mail address, type o
user, and area of focus then selec
Register.  Once you’ve registered
confirmation will be sent to your
mail address.   
 

 

On Campus  
To access or set up a RefWorks account from a computer on 
campus, you can go to http://www.refworks.com/refworks/. 
RefWorks will recognize the Penn IP address and the 
RefWorks User Login for University of Pennsylvania Library 
window will appear.  Select Sign up for an individual account
or log in if you already have one. 
 
Off Campus  
If you are off campus you’ll need to go through the Library 
web by searching for RefWorks in the E-Resource Locator 
search box at www.library.upenn.edu and clicking on the 
RefWorks link.  You’ll be asked to authenticate with your 
PennKey and password, and the RefWorks User Login for 
University of Pennsylvania Library window will appear.  
Select Sign up for an individual account or log in if you 
already have one. 
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The RefWorks Window 
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Entering Citations into RefWorks 

Once your account has been established, you will be ready to begin populating your RefWorks 
database with citations.  There are a number of ways to enter citations into RefWorks, including 
manually entering citations, importing citations from online databases, and using the Search 
Online Database feature.  

Manually Entering Citations  
To enter a citation into RefWorks, select Add New Reference under the References menu.  The 
New Reference screen will appear.  First, select a format from the View Required Fields for: 
pulldown menu.  If you are unsure which format to select, the default is perfectly acceptable.  
Next select a folder for your citation from the In Folder(s) pulldown menu, and the citation 
format (book, journal article, etc.) from the Ref Type pulldown menu.  Enter your citation.  
Separate multiple authors and descriptors by semicolon, and enter authors with the last name first.  
When you’re finished entering the information, click the Save button.  You then have the option 
to Duplicate, View, or go Back to the Reference List.  

Direct Export from Electronic Resources to RefWorks  
Rather than manually enter citations, you also have the option to import citations directly from 
many online databases (FirstSearch, ProQuest, etc.).  A list of databases that have the Direct 
Export function and instructions for using them is available at 
http://hdl.library.upenn.edu/1017/15010.
 
After you activate the Export feature, the RefWorks window will come to the front of your 
screen, and you’ll see a message indicating that the references are being imported and when 
the import is complete. 
 

 

Once you have imported the records you can view them in the Last Imported Folder, add 
keywords, and organize them into folders. 
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Saving Citations from Electronic Resources as Text and Importing into 
RefWorks  
While many databases do have the Direct Export feature, some do not.  Many of these other 
databases have the option of saving your citations as a text file on your computer and 
importing them into RefWorks.  Use the information at 
http://hdl.library.upenn.edu/1017/15010 to determine whether a database allows this and to 
see instructions as to how it is done.   
 
Once you’ve saved your citations into a text file on your computer, go to RefWorks and 
select Import under the References menu. The Import screen will appear.  
 

 
1. Select University of Pennsylvania Library as the Import Filter/Data Source.  
2. Select the database from which you saved your citations as the Database.  
3. If you want, specify the folder within RefWorks to which the citations will be 

imported.  
4. Be sure that Import Data from the following Text File radio button is selected.  
5. Click on the Browse button to navigate to your text file and select it.  
6. Scroll to the bottom of the screen and select Import. 
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Search Online Databases 
The Search Online Database feature 
allows you to search library catalogs 
from within RefWorks.  Go to the 
Search menu and choose Online 
Catalog or Database, and the Search 
Online Databases screen will appear. 
Select the library catalog to search 
from the pulldown menu, indicate how 
many references to download at one 
time in the Max. Number of References 
to Download pulldown menu, enter 
your search terms, and click Search.  
 

 

 

Using Quick Search with Franklin  
In the Online Database to Search pulldown menu, select University of Pennsylvania.  Enter 
your terms into the Quick Search field. RefWorks will automatically put an OR between your 
terms.  If you enter the phrase “Art Smith”, it will search for the terms “Art” OR “Smith” 
across all fields in a citation.  If you want to use AND to join terms, you’ll need to use the 
Advanced Search area of the screen and select Any Field from the pulldown menus.  

Using the Advanced Search with Franklin  
The Advanced Search allows you to search for authors, titles, subject headings, publication 
years, as well as build Boolean searches.  
Authors = Search for author name. Enter “Jane Smith” or “Smith, Jane.”  
Descriptors = Subject search. Enter a word or phrase, such as “Animal intelligence.”  
Title = Title search. Enter the complete title or the beginning of the title “Catcher in the.”  
Pub Year = Publication year. Enter the year as four digits – 1938.  
Any Field = Searches across all fields. You can use the Boolean operators (AND, OR, NOT) 
in the pulldown menu to combine terms.  
 
Once you have your terms entered, click on the Search button.  Your results will appear in a 
new RefWorks window.  
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 Using the checkbox 

feature to select citations 
and the Import button, you 
can move your citations to 
your RefWorks database.  
If you select a specific 
folder from the Import to 
Folder pulldown menu, 
you can place your 
citations directly to a 
particular folder. 

 

 
 
 
 

PennText Links in RefWorks for Finding Full-Text 
 

PennText Links in RefWorks  
In the upper right corner of your citation, you may see a button labeled PennText.  If you 
click on this button, you will link to the University Library PennText menu. 

 

 PennText 
Link  
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Click for Full-Text online. 
 
Click to check for print copies.
 
Click to request from another 
library. 



Organizing and Searching Your RefWorks Database 
 

Creating Folders for Citations  
RefWorks allow you to create folders to organize your citations.  To create a folder, go to the 
Folders menu and select Create New Folder.  Type the name of your folder in the New 
Folder Name field and click on the OK button.  You can create an unlimited number of 
folders within your RefWorks account. You can also place the same reference in more than 
one folder.  

Copying Citations to Folders  
As outlined above, you can create folders for your citations.  To move your citations into 
folders, use the checkbox feature next to the citation to select it.  Go to the Put in Folder 
pulldown menu and select the folder in which you want to place the citations. A javascript 
message will appear that asks “Are you sure you want to put the 2 selected references in the 
[Selected] folder?” Click OK.  You’ll then see a message indicating that your citations have 
been successfully put in the folder.  You may need to click OK again.  

 
Searching for Citations in Your RefWorks Database  
The Search RefWorks field on the top right side of the screen searches across your RefWorks 
database.  It looks in all fields, including the abstract and custom fields.  All search terms are 
connected by the Boolean connector AND.  It also searches for embedded terms, i.e., if you 
search for “art” you will retrieve references with “heart”, “part,” etc. Advanced Search 
(located under the Search menu) allows you to limit your search to specific fields (author, 
title, abstract, etc.), select Boolean operators (and, or, not), as well as select the folders you 
wish to search.  
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Global Edit and Look Up 
Features 
 
RefWorks also has a Lookup feature 
that allows you to browse by author, 
descriptor, and periodical title.  Click 
on the Search menu and choose 
Lookup by Author, Descriptor or 
Periodical and the browse window 
will appear. Use the entry and edit 
links to view the citation and make 
global changes. 

 
 
Adding Descriptors  
You may want to add your own descriptors to your citations.  Mark the relevant citations or 
decide to add a descriptor to every record in a folder and click the Global Edit button.  The 
Global Edit screen will appear. On this screen choose ‘Descriptor’ as the field to edit, add a 
term to the ‘Change Field to:’ box and click ‘OK.’  
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Sharing Your RefWorks Database on the Web 

Providing Read-Only Access 

You can provide read only access to an account that you have already created by using the 
‘Update User Information’ function in the Tools menu to create a read-only password.  
Individuals who have their own RefWorks accounts will be able to use their login name and 
the read-only password to search your database, export data and create bibliographies. They 
will not be able to edit references, import references or change folders. 

Read-Only Access 
RefWorks allows you to provide read-
only access to your database.  By 
creating and sharing a Read-only 
password, others will be able to search 
your database, export data, and create 
bibliographies but will not be able to edit 
or import references or change folders.  
To make your database read-only, go to 
the Tools menu, then Settings, and then 
choose Update User Info.  Enter a read-
only password and click Update. With 
your login name and read-only password 
users will be allowed to access your 
database in read-only mode 

 

Using RefWorks for Group Research Projects  
RefWorks is a great tool for group research projects.  By creating an account to share, you 
and your group members will be able to add citations from anywhere you have Internet 
access.  Here are some steps and tips to help you to use RefWorks efficiently as a group.  

Create a Separate Account for the Group  
You create a group account the exact same way you create an individual account, by 
selecting Sign up for an Individual Account from the main RefWorks screen. When creating 
your account, choose a Login Name and Password that will make sense to the members of 
your group.  For example, pick something that has the class or project name in it, like 
“arteducation” or “biochemlab4.” Share the login and password with your group members.  

Use Folders to Organize Citations  
To facilitate organization amongst group members, create folders to store your citations. You 
could create folders for different topics and/or a folder for each person working on the 
project – whatever works best for your group.  Citations can display in multiple folders.  To 
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create a folder, select Create New Folder under the Folders pulldown menu. Type the name 
of your folder in the New Folder Name dialog box and click on the OK button.  

Create Consistent Vocabulary Using Descriptors  
Use descriptors to create a consistent vocabulary across your RefWorks database.  This will 
make it easier for you to search and retrieve relevant citations within your RefWorks 
database.  If you’ve imported citations from a number of online library resources, different 
terms may be used to describe a similar thing.  For example, the words “juvenile” and “child” 
both may be used to describe kids, but your group may always want to use the word, “child.” 
To change all occurrences of “juvenile” to “child,” go to the Search menu and select 
Lookup by Descriptor.  Here you’ll see all the different descriptors online resources use to 
describe the content of an article.  If you wanted to change every occurrence of the descriptor 
‘juvenile’ to ‘child,’ select the Edit link to the right of the term ‘juvenile’ and in the To field 
enter ‘child.’ Changes will be made globally across your account.

Select an Account Manager  
Select someone from your group to periodically check for duplicates, make sure citations are 
in the proper folders, etc.  

 
Backing-up Your RefWorks Database 

You can backup your citations on your computer by using the Backup/Restore feature. Go to 
the Tools menu and select Backup/Restore.  You’ll then be presented with the option to 
Include References and/or Include Output Styles.  Click on the Perform Backup button.  A 
copy of your database will be downloaded to your computer. 
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Inserting References into Word Documents 

Using Write-N-Cite to Add References 
You can use RefWorks’s Write-N-Cite function to insert references within Word.  To use 
Write-N-Cite you will need to download a small utility program from this site: 
http://www.refworks.com/Refworks/WNCDownload.asp.  Once the download is complete 
you can open it in Word by clicking the toolbar icon or by selecting it from the Tools drop 
down menu.  Click on the Write-N-Cite icon in Word to open the Write-N-Cite window. 

 
Write-N-Cite Window 

 

 
Clic
The 
(see

 

 

Click Cite to insert the 
reference into Word 

k on the Cite link to the left of an entry to insert it as a reference in the Word document.  
reference will appear in the standard RefWorks style until the Bibliography is formatted 
 the ‘Formatting’ section).   

This is the way to add citations in RefWorks {{101 Tipler,F J. 2005; }}. 
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Using the One Line/Cite to Add References 
You can insert citations into a document and format bibliographies using the One Line/Cite 
View Manuscript as long as you use one of the compatible web browsers: Netscape 6.0 and 
above, Internet Explorer 5 and above, Mozilla 1.2.1, and Safari.  Check the RefWorks 
website for the latest information about browser compatibility (http://www.refworks.com).   
 
To cite a reference in your paper, you’ll need to switch to the One Line/Cite View in 
RefWorks as in the Switch to dropdown menu as shown in the first image on the next page.  

 
 

 
 

Cite Link 

Switch Views 

Click on the Cite link next to the appropriate reference.  A Citation Viewer window will 
appear containing the citation formatted like {{92 Deckha, Nityanand 2004;}}.  Once you 
have all of the references you need for a particular in-text citation, click on the Select 
Citation button.  Drag and drop the citation into your word processor document or copy the 
citation and paste it in the Word document.  Be sure to clear the Citation Viewer window 
before creating your next citation.

 

 

Microsoft Word Document 
 

Deckha writes that Historic 
preservation is important {{92 
Deckha,Nityanand 2004;}}.  In 
London, for example…. 

 
Editing Unformatted Citations 

 
Once you have added a RefWorks citation to the word document you can edit it to: 
 

• supress (hide) an entire citation 
• supress (hide) the author 
• supress (hide) the year 
• add text before the in-text citation 
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• add text after the in-text citation 
• add a specific page number (overriding the page number in your RefWorks 

record).  This feature only works if the output style you plan to use has page 
numbers in the in-text citation or footnote. 

To edit a citation position the cursor within that citation and then enter the Write-N-Cite tool 
and click on the ‘Edit Citation’ link in its top right corner.  This will open the citation editor.  
After you have completed your editing click ‘Save to Word’; the changes will then appear in 
the RefWorks citation in the Word document  

 
Citation Editor 

 
 
 

Formatting your Document and Creating a Bibliography 
 

Creating a Bibliography  
Save the document you have just created before formatting the paper and the bibliography.  
Click on the Bibliography button from the Citation Viewer window or the Bibliography 
menu from the main RefWorks window. Select the Output Style (APA, MLA, specific 
journal), select the Format Paper and Bibliography button, and use the Browse button to 
navigate to your manuscript. Click on Create Bibliography.  The formatted document will be 
downloaded to your computer and it may have an .asp extension.  If the formatted manuscript 
does not open, go to Word and open the manuscript from within Microsoft Word.  You can 
now save and edit the manuscript. 
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Choose to format a word document or create a 
bibliography without making a document. 

 
Creating a Bibliography From a List of References  
In RefWorks, you can create a bibliography from a list of referenc
manuscript.  This reference list may contain your entire database o
specific folder.  Click the Bibliography button from the Citation V
Bibliography menu from the main RefWorks window.  Select the
the Output Style pulldown list.  Click Format a Bibliography from
Under File Type, select the file format you wish to create (Text, H
Word for Windows (97 or later), or Word for Mac (98 or later).  U
References or References from <folder name>. Click Create Bibli
downloaded to your computer.  Save the document and edit as nee

 
Help with RefWorks 

 
If you have particular questions about RefWorks or would like to 
meet with a librarian for assistance, send a request for assistance t
mailto:library@pobox.upenn.edu.  
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